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Installing CD One

This chapter consists of:

• Installation Overview

• Preparing to Install CD One

• Performing a New Installation

• Performing an Upgrade Installation

• Verifying the Installation

• Removing CD One
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Installation Overview
Installation Overview
Table 2-1 is an overview of CD One installation tasks. It contains references to 
more detailed information about each task. The table describes a typical local 
installation. 

For information on custom installations, see Custom Installation, page 2-10. 

For information on remote installations, see Performing an Upgrade Installation, 
page 2-13.

Table 2-1 Installing CD One Task Overview

Task Steps References

Prepare to install 
CD One.

1. Verify that server requirements 
are met.

“Prerequisites” chapter, “Server 
Requirements” section on page 1-3

2. Install required Microsoft 
software on the server if it is not 
already installed.

“Installing Required Microsoft Software” 
section on page 2-4

3. Verify that client requirements 
are met.

“Prerequisites” chapter, “Client 
Requirements” section on page 1-4

4. Note TCP ports that 
CiscoWorks2000 uses and check 
for conflicts with existing 
applications.

“TCP and UDP Ports Used” section on 
page 2-6

Install server 
software.

Run installation program. “Performing a New Installation” section 
on page 2-7

Verify and 
troubleshoot 
installation.

1. Verify that all correct services 
are installed.

“Verifying the Installation” section on 
page 2-24

2. Analyze installation error 
messages.

“Troubleshooting the Installation” 
appendix, “Understanding Installation 
Messages” section on page A-4 
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Installation Notes
During installation, you might see warnings from the Windows 2000 or 
Windows NT system that it has found a read-only file. You can choose Yes to 
overwrite the file, No not to overwrite the file, or Cancel to cancel the installation. 
If you cannot continue the installation, call your technical support representative 
for assistance.

You might also see warnings that the installation system is running out of disk 
space. You can choose to free disk space on the system and click Yes to continue, 
or click No to exit the installation.

CD One is installed in the default directory C:\Program Files\CSCOpx. If you 
select another directory during the installation, CD One will be installed in that 
directory.

Note Do not select an encrypted directory. CiscoWorks2000 does not support 
directory encryption.

Preparing to Install CD One 
Before you install CD One, make sure your server and client environments meet 
the hardware and software requirements described in the “Prerequisites” chapter. 

You must be a member of the local administration group to install CD One.

Do not:

• Use DHCP running in dynamic mode on the CiscoWorks2000 Server.

• Install CiscoWorks2000 on a system that is configured as a primary or backup 
domain controller, or as a terminal server.

• Install CiscoWorks2000 on a FAT file system.

Note If you are running HP OpenView, the installation might take 
significantly longer to complete. Please stop all HP OpenView 
services before installing CD One.
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Installing Required Microsoft Software
Depending on your system, installing the software might require three or more 
Microsoft software application installations.

The major steps required for installing the CD One software are:

1. Make sure the system has Microsoft Windows NT Server 4.0, Microsoft 
Windows NT Workstation 4.0 (US English or Japanese versions), or 
Microsoft Windows 2000 installed.

2. If you are running Windows NT, make sure Service Pack 6a is installed. To 
verify the currently installed service pack:

Note You do not need to remove previous service pack versions.

a. Select Start > Run.

b. Type winver.

If Version 4.0 Build 1381: Service Pack 6a appears, Service Pack 6a 
is already installed.

If this information does not appear, Service Pack 6a is not installed. 
Install it now. Refer to the Microsoft web site.

Note When installing the service pack, select either the Standard 40 bit 
encryption or the High 128 bit encryption. If you have previously 
installed 128 bit components on your system, download the High 
128 bit encryption version.

Caution If you are not familiar with the Windows NT 4.0 service packs, refer to the 
Microsoft Web site for additional information. If you install the software 
incorrectly, you will be unable to install CD One successfully.

If you are running Windows 2000, make sure Service Pack 1 is installed. To verify 
the currently-installed service pack:

a. Select Start > Run.
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b. Type winver.

If 5.0.2195 Service Pack 1 Build 2195 appears in the Version field, 
Service Pack 1 is already installed.

If this information does not appear, Service Pack 1 is not installed. Install it now. 
Refer to the Microsoft web site.

3. Make sure Internet Explorer 5.5 with Service Pack 1 is installed and running 
JVM version 5.0.0.3167 (or current shipping version). To verify the JVM 
version:

a. Select View > Java Console. 

b. If Java Console is not listed in View, enable it now. Select 
Tools> Internet Options >Advanced. 

c. In the Java VM section, select the Java Console option. 

d. Restart Internet Explorer.

To download the supported JVM version, refer to the Microsoft web site.

4. Make sure ODB Driver Manager 3.510 or later is installed. To verify the 
version of ODBC Driver Manager:

a. For Windows 2000, select Start > Settings > Control Panel > 
Administrative Tools > ODBC, or for Windows NT, select 
Start > Control Panel > Data Sources (ODBC).

b. Select the About tab. 

If necessary, install Microsoft Data Access Component (MDAC) 2.5 or later. 

Note Make sure that all ODBC Core Components have the same version 
number. 

Refer to the Microsoft web site for installation instructions.

Note The download and installation programs for these required software 
packages are subject to change by Microsoft at any time. For this 
reason, it is not possible to provide exact instructions for the 
installation of the required Microsoft software.
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Key Installation Points

Remember these points when installing the required server software:

• Always keep the newer file whenever you are prompted by an installation 
program to replace a newer file with an older file.

• Always reboot your system when you are prompted to do so by an installation 
program.

• You might be asked to register with Microsoft before downloading some of 
the required software. Complete the registration as you wish. Selections you 
make during registration will not affect the installation.

TCP and UDP Ports Used
In addition to the standard network ports, CD One uses the following TCP and 
UDP ports:

• 42340/tcp (CiscoWorks2000 Daemon Manager, the tool that manages server 
processes)

• 42342/udp (Osagent)

• 42343/tcp (JRun)

• 42344/tcp (ANI HTTP server)

• 7500/udp (Electronic Switching System [ESS] Service port)

• 7500/tcp (ESS Listening port)

• 7580/tcp (ESS HTTP port)

• 7588/tcp (ESS Routing port)

• 1741/tcp (port used for the CiscoWorks2000 HTTP server)

See the “Preparing to Use CD One” chapter for information about accessing 
the server.
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Performing a New Installation
The CD One installation program takes approximately 30 minutes to complete on 
a PC with the minimum required hardware. This can extend to one hour if you 
perform network management integration during the installation process. 

For information on setting up multi-homed machines, refer to the Release Notes 
for CiscoWorks2000 CD One, 4th Edition. 

Running the Installation Program—New Installation
To run the installation program:

Step 1 Install the required software as described in the “Server Requirements” section on 
page 1-3.

Caution If you are running Windows NT, make sure Service Pack 6a is installed. If you 
are running Windows 2000, make sure Service Pack 1 is installed. Without the 
appropriate service pack installed, CD One will install with a warning to 
proceed at your own risk. 

Step 2 Insert the CD One CD-ROM into a CD-ROM drive. 

The Installer screen appears.

Step 3 Click Install to continue. The Welcome screen appears.

Step 4 Click Next to continue. The Setup Type dialog box appears.

Step 5 Select one of the following:

• Typical to install all CD One components in the default location
(See the “Typical Installation” section.)

• Custom to select optional components and to specify the location
(See the “Custom Installation” section.)
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Typical Installation
If you select the typical option: 

Step 1 Click Next to continue. The Start Copying Files dialog box appears, verifying 
current settings.

Step 2 Click Next to continue. A Requirements Verification dialog box appears.

Step 3 Click OK. The installation script checks dependencies, then the Integration 
Utility dialog box appears.

Step 4 Select one of the following:

• Later to integrate with a third-party NMS after installation. Later is the 
recommended choice to complete the installation more quickly, and to avoid 
faulty third-party installation errors. 
If you select Later, go to Step 5.

• Now to integrate with a third-party NMS during installation.
If you select Now, continue with steps a through c.

a. Click Next to continue. The Integration Utility dialog box appears, displaying 
a list of adapters.

b. Select the adapter from the list of available adapters, or select other to choose 
an adapter that is not listed (you will be prompted to enter the path name of 
the adapter), or select none to integrate after the installation is complete.
If you select none, go to Step 5.

The Integration Utility dialog box appears, asking if you want to enable 
download options from the Cisco Web page (CCO). 

c. Select one of the following:

• No to not enable future upgrades from the Cisco Web page. 

• Yes to enable future upgrades from the Cisco Web page.
Enter your CCO user ID and password.

Note You must have CCO login privileges. If you do not have a user 
account and password on CCO, contact your channel partner or 
enter a request on the standard CCO web site (www.cisco.com).
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Step 5 Click Next to continue.

Note A dialog box might display services that are running. To stop the 
services and continue the installation, click Yes.

When the installation is complete, the Restart Windows dialog box appears, 
asking if you want to restart your system. 

Step 6 Select Yes, then click Finish.

CD One is installed in the default directory, C:\Program Files\CSCOpx.

Step 7 Prepare the client system for use. See the “Preparing to Use CD One” chapter.

Caution You must restart your system when installation is complete to restart the 
processes.

Note For troubleshooting information or to verify the directories installed on your 
system, see the “Troubleshooting the Installation” appendix.
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Custom Installation
If you select the custom option:

Step 1 Click Next to continue. The Select Destination dialog box appears.

Note If CD One has previously been installed on this machine, the Select 
Destination dialog box will not appear and the product will 
automatically be installed in the same location CD One was previously 
installed.

Step 2 Click Next to accept the default location, or select a different location then click 
OK, then Next. 

Note Do not select an encrypted directory. CiscoWorks2000 does not 
support directory encryption.

The Select Components dialog box appears.

Step 3 Select one of the following:

Note If CD One has previously been installed on this machine, the list of 
components will be different.

• NMS Integration Utility to install only the Integration Utility.
(For information about the Integration Utility and third-party NMS 
integration, refer to Using CiscoView.) 

• Common Management Foundation (CMF) Base Desktop to install a 
subset of CMF.
(Select this option only if the application you’ll be installing next requires the 
CMF Base Desktop and you do not want CiscoView or NMS Integration 
Utility installed.)

• CiscoView to install only CiscoView.

• CiscoView, NMS Integration Utility, and CMF to install all CD One 
components (recommended for most systems).
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Step 4 Click Next to continue. 

The Start Copying Files dialog box appears, verifying current settings and 
selected components.

Note If you selected the Cisco View or the CMF Base Desktop option, go 
to Step 7.

Step 5 Click Next to continue. The Requirements Verification dialog is displayed. The 
installation checks dependencies, and the Integration Utility dialog box appears.

Step 6 Select one of the following:

• Later to integrate with a third-party NMS after installation. Later is the 
recommended choice to complete the installation more quickly, and to avoid 
faulty third-party installation errors.
If you select Later, go to Step 7.

• Now to integrate with a third-party NMS during installation.
If you select Now, continue with steps a through c.

a. Click Next to continue. The Integration Utility dialog box appears, displaying 
a list of adapters.

b. Select the adapter from the list of available adapters, or select other to choose 
an adapter that is not listed (you will be prompted to enter the path name of 
the adapter), or select none to integrate after the installation is complete.
If you select none, go to Step 7.

The Integration Utility dialog box appears, asking if you want to enable 
download options from the Cisco Web page (CCO).

If you are installing only the Integration Utility, enter the CiscoWorks2000 
server name and HTTP port.

c. Select one of the following:

• No to not enable future upgrades from the Cisco Web page. 

• Yes to enable future upgrades from the Cisco Web page.
Enter your CCO user ID and password.
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Note You must have CCO login privileges. If you do not have a user 
account and password on CCO, contact your channel partner or 
enter a request on the standard CCO web site (www.cisco.com).

Step 7 Click Next to continue. 

Note A dialog box might display services that are running. To stop the 
services and continue the installation, click Yes.

When the installation is complete, the Restart Windows dialog box appears, 
asking if you want to restart your system.

Step 8 Select Yes, then click Finish.

CD One software is installed in the default directory, C:\Program Files\CSCOpx, 
or the directory specified.

Step 9 Prepare the client system for use. See the “Preparing to Use CD One” chapter.

Caution You must restart your system when installation is complete to restart the 
processes.

Note For troubleshooting information, see the “Troubleshooting the Installation” 
appendix.
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Performing an Upgrade Installation
During a local upgrade from a previous version of CD One, the data is preserved. 
However, during a remote upgrade from previous version of CD One, data must 
be manually imported. During an upgrade from previous CiscoWorks2000 
applications (prior to CD One, 1st Edition), previous product versions are 
removed, but the database, ANI information, community strings, user and host 
information, and application-specific data files are preserved and will be restored 
during the new product version installations.

For a description of the different upgrade paths and their results, refer to the “CD 
One Upgrade” section on page 1-2.

To upgrade from versions of applications prior to CD One, 1st Edition, see the 
“Upgrading from Applications Prior to CD One” section on page 2-13.

To upgrade from any previous edition of CD One, see the “Upgrading from 
Previous Editions of CD One” section on page 2-15.

Upgrading from Applications Prior to CD One
You can upgrade to the new version of CD One using either of two methods. You 
can perform a local upgrade by installing the new version on the machine 
currently running applications prior to CD One, replacing the current 
applications. As an alternative, you can perform a remote upgrade by installing 
CD One, 4th Edition, on a new machine, and exporting essential data from the 
machine running applications prior to CD One.

To perform a local upgrade from applications prior to CD One, see the “Upgrading 
from Applications Prior to CD One—Local Upgrade” section on page 2-14.

To perform a remote upgrade from applications prior to CD One, see the 
“Upgrading from Applications Prior to CD One—Remote Upgrade” section on 
page 2-15.
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Upgrading from Applications Prior to CD One—Local Upgrade

To run the installation program:

Step 1 Install the required software as described in the “Server Requirements” section on 
page 1-3.

Caution If you are running Windows NT, make sure Service Pack 6a is installed before 
you remove the previous version of CD One. If you are running Windows 
2000, make sure Service Pack 1 is installed. Without the appropriate service 
pack installed, CD One will install with a warning to proceed at your own risk. 

Step 2 Insert the CD One CD-ROM into a CD-ROM drive. 

The Installer screen appears.

Step 3 Click Install to continue. The installation program detects any previous product 
versions installed on your system, and lists them on the Previous Versions Found 
screen.

Step 4 Click Yes to continue the installation. The Where to Store Data? screen appears.

Step 5 Click Next to accept the default location, or browse to select the folder in which 
you want to save a copy of your existing data. 

Note Refer to the online help for your specific applications for information 
about importing data into new application versions.

The Uninstall Previous Versions? screen appears.

Step 6 Click Yes. The Confirm File Deletion dialog box appears. 

Step 7 Click Yes.

The unInstallShield removes the previous version of the application.

Step 8 Click Ok to finish uninstalling. The Welcome screen appears.

Step 9 See the “Performing a New Installation” section on page 2-7 to continue the 
installation process.
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Upgrading from Applications Prior to CD One—Remote Upgrade

Step 1 Install CD One on the new machine. See the “Performing a New Installation” 
section on page 2-7.

Step 2 Refer to the online help for your specific applications for information about 
importing data into new application versions.

Upgrading from Previous Editions of CD One 
You can upgrade to the new version of CD One using either of two methods. You 
can perform a local upgrade by installing the new version on the machine 
currently running a previous version, replacing the previous version. As an 
alternative, you can perform a remote upgrade by installing CD One, 4th Edition, 
on a new machine, and exporting essential data from the machine running the 
previous version of CD One to the new machine. 

To perform a local upgrade from previous versions of CD One, see the “Upgrading 
from Previous Editions of CD One—Local Upgrade” section on page 2-16.

To perform a remote upgrade from previous versions of CD One, see the 
“Upgrading from Previous Editions of CD One—Remote Upgrade” section on 
page 2-22.
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Upgrading from Previous Editions of CD One—Local Upgrade

Before starting an upgrade from an older version of CD One to CD One, 4th 
Edition, all currently scheduled jobs must be suspended. Necessary data can then 
be exported during upgrade to the new version. This data allows individual 
applications to re-enable jobs after upgrade. To make this possible, you must first 
install a patch on the old system. The patch is shipped with CD One.

To install the patch:

Step 1 Insert the CD One CD-ROM into a CD-ROM drive. 

Step 2 At the command line, enter:

perl patch_1x_20.pl

The patch copies the file DisableJobs.class to the runtime installation directory. 

Step 3 At the command line, enter:

cwjava -cw install directory com.cisco.nm.cmf.jrm.DisableJobs

The class file suspends all the jobs and creates a list of job IDs for the suspended 
jobs and other job information in a file called joblist.jrm. The file joblist.jrm is 
saved in $NMSROOT/setup. Jobs are re-enabled as part of the upgrade process for 
individual applications.

Now that the patch is installed, you can install CD One, 4th Edition.

To run the installation program:

Step 1 Install the required software as described in the “Server Requirements” section on 
page 1-3.

Caution If you are running Windows NT, make sure Service Pack 6a is installed before 
you remove the previous version of CD One. If you are running Windows 
2000, make sure Service Pack 1 is installed. Without the appropriate service 
pack installed, CD One will install with a warning to proceed at your own risk.

Step 2 Insert the CD One CD-ROM into a CD-ROM drive. The Installer screen appears.
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Step 3 Click Install to continue. The Welcome screen appears.

Step 4 Click Next to continue. The Setup Type dialog box appears.

Step 5 Select one of the following:

• Typical to install all CD One components in the default location
(See the “Local Upgrade from Previous Editions of CD One—Typical” 
section.)

• Custom to select optional components and to specify the location
(See the “Local Upgrade from Previous Editions of CD One—Custom” 
section.)

Local Upgrade from Previous Editions of CD One—Typical 

If you select the typical option:

Step 1 Click Next to continue. The Start Copying Files dialog box appears, verifying 
current settings.

Step 2 Click Next to continue. A Requirements Verification dialog box appears. 

Step 3 Click OK. The installation script checks dependencies. If you are upgrading from 
CD One 1.0 or 1.1, a dialog box appears, notifying you that existing CV Device 
Packages will be removed. Click OK to continue.

Step 4 The Integration Utility dialog box may appear. If your previous version of 
CiscoWorks2000 is already integrated with a third-party NMS, enter your CCO 
user ID and password into the dialog box, and go to Step 6.

Step 5 Select one of the following:

• Later to integrate with a third-party NMS after installation. Later is the 
recommended choice to complete the installation more quickly, and to avoid 
faulty third-party installation errors. 
If you select Later, go to Step 6.

• Now to integrate with a third-party NMS during installation.
If you select Now, continue with steps a through c.

a. Click Next to continue. The Integration Utility dialog box appears, displaying 
a list of adapters.
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b. Select the adapter from the list of available adapters, or select other to choose 
an adapter that is not listed (you will be prompted to enter the path name of 
the adapter), or select none to integrate after the installation is complete.
If you select none, go to Step 6.

The Integration Utility dialog box appears, asking if you want to enable 
download options from the Cisco Web page (CCO).

c. Select one of the following:

• No to disallow future upgrades from the Cisco Web page. 

• Yes to enable future upgrades from the Cisco Web page.
Enter your CCO user ID and password.

Note You must have CCO login privileges. If you do not have a user 
account and password on CCO, contact your channel partner or 
enter a request on the standard CCO web site (www.cisco.com).

Step 6 The Information dialog box appears, stating that the installation of CiscoView 5.3 
will remove all existing device support files and replace them with the files found 
in CD One, 4th Edition. To access a list of CiscoView 5.3 and existing device 
support files, navigate to the directory specified at the end of the message.

Note The device support files installed with CD One, 4th Edition may be 
older than the files currently on your system. If that is the case, 
download the latest device support files from www.cisco.com.

Step 7 Click OK.

Note A dialog box might display services that are running. To stop the 
services and continue the installation, click Yes.

When the installation is complete, the Restart Windows dialog box appears, 
asking if you want to restart your system.
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Step 8 Select Yes, then click Finish.

CD One software is installed in the default directory, C:\Program Files\CSCOpx, 
or the directory specified.

After the upgrade is complete, all jobs are in a suspended state. Jobs are 
re-enabled as part of the upgrade process for individual applications.

Step 9 Prepare the client system for use. See the “Preparing to Use CD One” chapter.

Caution You must restart your system when installation is complete to restart the 
processes.

Note If you cannot install CD One, see the “Troubleshooting the Installation” 
appendix.

Local Upgrade from Previous Editions of CD One—Custom 

If you select the custom option:

Step 1 Click Next to continue. The Select Destination dialog box appears.

Note If CD One has previously been installed on this machine, the Select 
Destination dialog box will not appear and the product will 
automatically be installed in the same location CD One was previously 
installed.

Step 2 Click Next to accept the default location, or select a different location then click 
OK, then Next. 

Note Do not select an encrypted directory. CiscoWorks2000 does not support 
directory encryption.

The Select Components dialog box appears.
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Step 3 Select one of the following:

Note If CD One has previously been installed on this machine, the list of 
components will be different.

• NMS Integration Utility to install only the Integration Utility.
(For information about the Integration Utility and third-party NMS 
integration, refer to Using CiscoView.) 

• Common Management Foundation (CMF) Base Desktop to install a 
subset of CMF.
(Select this option only if the application you’ll be installing next requires the 
CMF Base Desktop and you do not want CiscoView or NMS Integration 
Utility installed.)

• CiscoView to install only CiscoView.

• CiscoView, NMS Integration Utility, and CMF to install all CD One 
components (recommended for most systems).

Step 4 Click Next to continue. 

The Start Copying Files dialog box appears, verifying current settings and 
selected components.

Note If you selected the Cisco View or the CMF Base Desktop option, go 
to Step 7.

Step 5 Click Next to continue. The Requirements Verification dialog is displayed. The 
installation checks dependencies, and the Integration Utility dialog box appears.

Step 6 Select one of the following:

• Later to integrate with a third-party NMS after installation. Later is the 
recommended choice to complete the installation more quickly, and to avoid 
faulty third-party installation errors.
If you select Later, go to Step 7.

• Now to integrate with a third-party NMS during installation.
If you select Now, continue with steps a through c.

a. Click Next to continue. The Integration Utility dialog box appears, displaying 
a list of adapters.
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b. Select the adapter from the list of available adapters, or select other to choose 
an adapter that is not listed (you will be prompted to enter the path name of 
the adapter), or select none to integrate after the installation is complete.
If you select none, go to Step 7.

The Integration Utility dialog box appears, asking if you want to enable 
download options from the Cisco Web page (CCO).

If you are installing only the Integration Utility, enter the CiscoWorks2000 
server name and HTTP port.

c. Select one of the following:

• No to not enable future upgrades from the Cisco Web page. 

• Yes to enable future upgrades from the Cisco Web page.
Enter your CCO user ID and password.

Note You must have CCO login privileges. If you do not have a user 
account and password on CCO, contact your channel partner or 
enter a request on the standard CCO web site (www.cisco.com).

Step 7 The Information dialog box appears, stating that the installation of CiscoView 5.3 
will remove all existing device support files and replace them with the files found 
in CD One, 4th Edition. To access a list of CiscoView 5.3 and existing device 
support files, navigate to the directory specified at the end of the message.

Note The device support files installed with CD One, 4th Edition may be 
older than the files currently on your system. If that is the case, 
download the latest device support files from www.cisco.com.

Step 8 Click OK.

Note A dialog box might display services that are running. To stop the 
services and continue the installation, click Yes.

When the installation is complete, the Restart Windows dialog box appears, 
asking if you want to restart your system.
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Step 9 Select Yes, then click Finish.

CD One software is installed in the default directory, C:\Program Files\CSCOpx, 
or the directory specified.

After the upgrade is complete, all jobs are in a suspended state. Jobs are 
re-enabled as part of the upgrade process for individual applications.

Step 10 Prepare the client system for use. See the “Preparing to Use CD One” chapter.

Caution You must restart your system when installation is complete to restart the 
processes.

Note For troubleshooting information, see the “Troubleshooting the Installation” 
appendix.

Upgrading from Previous Editions of CD One—Remote Upgrade

If you do not want to overwrite your current version of CD One and replace it with 
CD One, 4th Edition, you can perform a remote upgrade instead. During a remote 
upgrade, you install CD One, 4th Edition, on a new machine, and export essential 
data to the new machine from the machine running the previous version. 

Step 1 Install CD One on the new machine. See the “Performing a New Installation” 
section on page 2-7.

Caution If you are planning to perform a remote upgrade, do not change the database 
password for the new version of CD One. Changing the password will make 
the target system's database inaccessible after the upgrade.

Step 2 Remove the CD One CD-ROM from the new machine.
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Performing an Upgrade Installation
Before starting an upgrade from an older version of CD One to CD One, 4th 
Edition, relevant data from all jobs must be exported to the new system. To make 
this possible, you must first install a patch on the old system. The patch is shipped 
with CD One.

To install the patch:

Step 1 Insert the CD One CD-ROM into the CD-ROM drive of the machine running the 
previous version of CD One. 

Step 2 At the command line, enter:

perl patch_1x_20.pl

Now that you have installed the patch, you can export the necessary job data from 
the old machine to the new one.

To export the data:

Step 1 The CD One CD-ROM should be in the CD-ROM drive of the machine running 
the old version of CD One. Go to the Root directory on the CD One CD-ROM.

Step 2 From the Root directory, run the script export_cdone.pl.

Step 3 Copy the directories $NMSROOT/rigel/cmf and $NMSROOT/rigel/manifest/cmf 
from the machine running the old version of CD One into the corresponding 
directories on the machine running the new version of CD One.

Step 4 On the new machine, go to the directory $NMSROOT/rigel/scripts, and run the 
script import_cdone.pl.

The upgrade is now complete, and all necessary job data from the previous version 
of CD One has been exported.
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Verifying the Installation
You can verify product installation by entering net start from a DOS prompt. The 
following services should be displayed:

• Apache WebServer

• CMF rsh/rcp service

• CMF syslog service

• CMF tftp service

• CW2000 Daemon Manager

• CW2000 VisiBroker Smart Agent

• JRun Proxy Server for CW2000

Note If you installed the CMF Base Desktop only, CW2000 VisiBroker Smart Agent 
will not be displayed.

Note If you upgraded from a previous version of CD One, when installation is 
complete, the system administrator should determine whether the bin user 
account can be safely removed.
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Removing CD One
Use the Uninstall option to remove CD One files and settings. You must be logged 
in as a local administrator to remove CD One.

Caution You must use the Uninstall option of the CD One installation program to 
remove the product. If you try to remove CD One or its components manually, 
you can damage your system.

Step 1 From the Windows desktop, select 
Start>Programs>CiscoWorks2000 >Uninstall CiscoWorks2000. 

The Uninstallation dialog box appears, displaying installed components.

Step 2 Select each component you want to remove.

Step 3 Click Next to begin uninstalling, then click Next again.

Messages about uninstall preparation appear and the uninstallation finishes. 
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